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Preface

Welcome to Thales Classic Client for Linux. 

This chapter presents an overview of Classic Client, the documentation provided with 

it, and additional resources available for working with Classic Client.

Classic Client

Classic Client is for individual users, who want to use a smart card/token to protect 

information and transactions made via computers.

With Classic Client you can use a digital certificate stored on a smart card/token to: 

■ Sign electronic documents.

■ Open and verify signed documents.

■ Send and receive secure e-mail using Mozilla e-mail software.

■ Connect securely with a Web server.

Classic Client also includes features for managing certificates and smart card/token 

security.

This guide introduces you to Classic Client and provides easy-to-follow instructions. 

Read the entire guide for assistance in the installation, configuration, and use of 

Classic Client.

Who Should Read This Book

This guide is intended for Classic Client users who are familiar with smart cards/tokens 

and smart card reader technology, as well as PC hardware and software. 

It is assumed that the user of Classic Client has:

■ an understanding of the basic operations in a Linux OS.

■ administrative privileges for the PC on which Classic Client will be installed.

Note: A token is in fact a smart card embedded in a device that can be plugged into 

the USB port of a PC. In this document, “connecting a device” can mean inserting a 

card in a reader or plugging a token in the USB port of a PC.
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Documentation

Classic Client is delivered with the following documentation:

■ Classic Client for Linux (this document).

■ End User License Agreement (EULA)

The EULA.rtf can be found after installation in the directory usr/share/doc/

libclassicclient.

This document is best viewed with Adobe Acrobat Reader, version 7.0 or later. You 

can download Adobe Acrobat Reader from Adobe’s Web site at: www.adobe.com.

Conventions

The following conventions are used in this document:

Typographical Conventions

Classic Client documentation uses the following typographical conventions to assist 

the reader of this document.

Additional Resources

For further information or more detailed use of Classic Client, additional resources and 

documentation are available by contacting Thales technical support. 

Support Contacts

If you encounter a problem while installing, registering, or operating this product, 

please refer to the documentation before contacting support. If you cannot resolve the 

issue, contact your supplier or Thales Customer Support.

Thales Customer Support operates 24 hours a day, 7 days a week. Your level of 

access to this service is governed by the support plan arrangements made between 

Thales and your organization. Please consult this support plan for further information 

about your entitlements, including the hours when telephone support is available to 

you.

Convention Example Description

Courier transaction Code examples.

Bold Enter libgclib.so Actual user input or screen output.

> Select File > Open Indicates a menu selection. In this example you are 
instructed to select the “Open” option from the 
“File” menu.

Note: Example screen shots of the Classic Client for Linux software are provided 

throughout this document to illustrate the various procedures and descriptions. These 

screen shots were produced with Classic Client running on Ubuntu. 

https://supportportal.thalesgroup.com/csm
http://www.adobe.com/products/acrobat/readstep2.html
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Customer Support Portal 

The Customer Support Portal, at https://supportportal.thalesgroup.com, is where you 

can find solutions for most common problems. The Customer Support Portal is a 

comprehensive, fully searchable database of support resources, including software 

and firmware downloads, release notes listing known problems and workarounds, a 

knowledge base, FAQs, product documentation, technical notes, and more. You can 

also use the portal to create and manage support cases.

Telephone

The support portal also lists telephone numbers for voice contact (Contact Us). 

If You Find an Error

Thales makes every effort to prevent errors in its documentation. However, if you 

discover any errors or inaccuracies in this document, please inform your Thales 

representative. Please quote the document reference number found at the bottom of 

the legal notice on the inside front cover.

Note: You require an account to access the Customer Support Portal. To create a new 

account, go to the portal and click on the REGISTER link.

https://supportportal.thalesgroup.com
https://supportportal.thalesgroup.com/csm?id=kb_article_view&sys_kb_id=42fb71b4db1be200fe0aff3dbf96199f&sysparm_article=KB0013367
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1

Installation

This chapter discusses information related to the installation of Classic Client for Linux.

The installation requirements are outlined below.

This chapter describes:

■ The hardware and software you need to use Classic Client for Linux.

System Requirements

The following sections describe the hardware, operating systems, peripherals and 

software you need to use for Classic Client. You must have administrator rights to the 

computer on which you are installing Classic Client.

Computer

The workstation must have at least 25 MB of available hard disk space and meet the 

normal system requirements to run the version of Linux installed.

Operating Systems

Classic Client for Linux supports the following operating systems:

The "What's In?" section of the Release Notes summarizes the OS that Classic Client        

supports.

Thales recommends that your machine has a RAM at least equal to that normally 

recommended for the OS. If this RAM requirement is met, Classic Client for Linux 

should run normally.
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Applications

For a detailed list of applications supported by Classic Client for Linux, refer to the 

Release Notes. Here are some useful links where you can download the latest versions 

of some software applications free of charge:

■ Mozilla Firefox and Thunderbird from www.mozilla.org.

Peripherals

Classic Client for Linux User Guide requires the following peripherals:

■ Smart card reader.

■ An available USB port.

For a detailed list of the smart cards and smart card readers supported by Classic 

Client for Linux, refer to the Release Notes.

Hardware and Software

Connecting the Smart Card Reader

To use Classic Client on your workstation, you must connect a smart card reader to 

your computer. 

If the card reader is not recognized on your workstation, you may need to install the 

latest card reader drivers. You can download these from 

https://supportportal.thalesgroup.com.

Configuring Thales Cryptographic Security Modules

Security Modules are software add-ons that provide a variety of cryptographic services, 

such as secure browsing, and support the use of smart cards/tokens. 

In Classic Client for Linux, the PKCS#11 security module is installed automatically as it 

is included with the Classic Client software.

In order to enable the Mozilla applications Firefox and Thunderbird to communicate 

with Classic Client, the PKCS#11 security module must be registered in the Mozilla 

application. 

To configure Firefox to recognize the security module: 

1 Open Firefox and from the Edit menu choose Preferences. 

2 In the dialog box that opens, click the Advanced icon, then the Certificates tab to 

display the settings as shown in “Figure 1”.

http://support.gemalto.com
http://support.gemalto.com
http://www.mozilla.org
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Figure 1 - Encryption Tab in Advanced Dialog

3 Click Security Devices to display the Device Manager window. This displays the 

modules currently available as shown in “Figure 2” on page 3.

Figure 2 - Device Manager
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4 Click the Load button to the right in the dialog. This displays the Load PKCS#11 

Device window, as shown in “Figure 3”.

Figure 3 - The Load PKCS#11 Device Dialog Box

5 Enter a Module Name.

6 In Module filename, enter the full path and filename for the libgclib.so file: 

By default, this is 

/usr/lib/ClassicClient/libgclib.so

7 Click OK.

The Device Manager indicates the presence of the new module as shown in 

“Figure 4”.

Figure 4 - Cryptographic Modules Available



Classic Client for Linux User Guide

D1573654A May 9, 2022 Copyright © 2022 Thales Group. All rights reserved.

2 

PIN Management

This chapter discusses the Classic Client PIN Management tool, the dedicated tool for 

managing PINs and the tasks it can be used to perform.

About PINs

PIN Types

Classic Client recognizes two types of PIN that may be in a smart card/token:

■ Admin PIN – the PIN that is necessary to unblock the smart card/token (for 

example after too many consecutive incorrect presentations of the User PIN).

■ User PIN – the standard PIN used by a user to access the smart card/token.

Administrator PIN

This is the PIN used to unblock a User PIN. Normally only administrators know the 

value of this PIN.

The administrator PIN is an extremely important part of the security of the smart card/

token. Knowledge of this PIN means you can change the value of all the user PINs on 

the smart card/token and unblock it if the user PIN is blocked.

It is extremely important for smart card/token administrators to keep the value of the 

Admin PIN secure and secret. The administrator must know the Admin PIN value for all 

smart cards/tokens he or she has deployed. The Admin PIN value of a smart card/

token should never be shared with anyone else, and it is strongly recommended not to 

give this value to the smart card/token user, unless your security policy requests it.

The original Admin PIN value of a smart card/token is included in the packaging of the 

smart card/token. If you are an administrator you may want to change the Admin PIN 

value of the smart cards/tokens you deploy so that only you, the administrator, knows 

it.

Caution: Once an administration PIN has been entered incorrectly the requisite 

number of times, it becomes blocked and the smart card/token can never be used 

again.
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User PIN

A PIN (Personal Identification Number) is a private code. It can be a sequence of 

numeric or alphanumeric characters or a mix of the two and is used as a type of 

password. Your User PIN must be verified before you can perform security tasks with 

the smart card/token, such as logging on to a workstation, or creating a digital 

signature.

The user PIN of a smart card/token may be the original PIN value set at the time of 

manufacture or it may be a PIN value assigned by the administrator.

The user PIN should be unique to your smart card/token and known only to you. It is 

standard practice, upon reception of a smart card/token, to change the user PIN value 

so that only you, the user, knows it. Your administrator can even force you to change 

the PIN value upon first use in the software.

To perform a security operation, you must prove that you know the User PIN. Software 

that performs a security operation usually displays a window requesting you to enter 

the PIN before performing the security operation.

■ When creating a digital signature, successful PIN validation proves that you are the 

real smart card/token holder and enables you to sign with the selected key. 

■ By using the PIN to log on a network, you prove both that your smart card/token is 

valid in the system and that you smart card/token holder, is physically there.

PIN Security Policies

PIN policies are established according to a company’s security policy, but they are also 

established in relation to the particular type of smart card/token you use and the on-

board software the smart card/token features. For example, some cards/tokens allow a 

user PIN to be a minimum of 4 characters, and other smart cards/tokens allow a 

minimum of 6 characters. Please see your smart card/token documentation for more 

information.

Classic Client PIN Management Tool

The Classic Client PIN Management tool allows you to make changes to the PINs 

associated with a particular smart card/token.

PIN Pad Readers

You can use the PIN Pad, “PC Pinpad” with the PIN Tool. PC Pinpad behaves like a 

normal reader in transparent mode.

Caution: Do not allow the User PIN for your smart card/token to be blocked. If, for 

example, you forget the user PIN and enter a predetermined number of failed 

validation attempts (the PIN is entered incorrectly), the smart card/token becomes 

blocked and you cannot perform any further security operations with it. If you know the 

Admin PIN you can unblock your smart card/token as described in “How to Unblock a 

PIN” on page 8. However most companies’ security policy does not allow this, in which 

case you must ask your Classic Client system administrator to unblock the smart card/

token using the Administrator PIN. Sometimes smart card/token technology or 

software on-board the smart card/token limits the absolute number of these 

unblocking operations. For more information, see your smart card/token technology 

documentation.
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PIN Management Tasks

This section describes the tasks that you can perform with the PIN Management Tool.

How to Access the Classic Client PIN Management Tool

To access the PIN Tool:

1 Make sure that your smart card/token is connected to your computer.

2 Either browse to /usr/bin/ and double-click CCChangePinTool or open a terminal, 

and type ./CCChangePinTool.

3 When the window shown in “Figure 5” appears, select a smart card reader from the 

list and click Apply.

Figure 5 - Selecting a Smart Card Reader for the PIN Management Tool

This opens the Classic Client PIN Management Window as shown in “Figure 6”.

Figure 6 - Classic Client PIN Management - Change PIN Function

How to Change a PIN

To change the Admin PIN, you will need to know its current value. This means that 

normally you will not be able to change an Admin PIN unless you are an administrator. 

To change a PIN

1 Connect the smart card/token whose Admin PIN/User PIN/Signature PIN you want 

to change to the PC.

2 Open the PIN Management window as described in “How to Access the Classic 

Client PIN Management Tool” on page 7.

3 If it is not already selected, click Change PIN at the top of the window (see “Figure 

6” on page 7).
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4 Select the PIN whose value you want to change from the list, Admin PIN, User PIN 

or Signature PIN.

5 Enter the current value of the PIN in Current PIN Code, and the new value in New 

PIN Code and again in Confirm New PIN Code.

6 Click the Change PIN button at the bottom of the window. A pop-up window 

appears to confirm a successful PIN change or to display an error message if 

unsuccessful.

How to Unblock a PIN

If you know the Admin PIN for your smart card/token, you can unblock your User PIN 

by using the Classic Client PIN Management tool. 

In most cases, if you are not an administrator you will not know the Admin PIN – it 

depends on your company’s security policy. In such cases, there are two possibilities:

■ The administrator must unblock the smart card/token for you. 

■ You must return the smart card/token to the administrator so he or she can unblock 

it on his or her PC.

To unblock a PIN as an administrator:

1 Connect the blocked smart card/token to your administrator PC.

2 Open the Classic Client PIN Management window as described in “How to Access 

the Classic Client PIN Management Tool” on page 7. 

3 If it is not already selected, click Unblock PIN at the top of the window as shown in 

“Figure 7” on page 8.

Figure 7 - Classic Client PIN Management - Unblock PIN Function

4 Enter the Admin PIN in Admin PIN, and the new value for the PIN in New PIN and 

again in Confirm New PIN.

5 For security reasons, Thales recommends that you check the box Force user to 

change PIN. This is particularly useful if the user whose PIN is being unblocked is 

not the administrator (as in most cases). For details on Force user to change PIN, 

refer to “Force Change PIN” on page 15.

Note: This section is applicable only for User PIN. It is not possible to unblock an 

Admin PIN. If the Admin PIN becomes blocked, the smart card/token can no longer be 

used.
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6 Click the Unblock PIN button at the bottom of the window. A pop-up window 

appears to confirm a successful Unblock PIN operation or to display an error 

message if unsuccessful. 
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3 

Fingerprint Authentication

This chapter provides information on fingerprint authentication in the Classic Client. 

Fingerprint authentication can be used as an alternative to PIN authentication. 

Fingerprint authentication is supported in the tasks mentioned in “Chapter 5 - Tasks”.

About Fingerprints

For cards that contain the IAS Classic Applet V3 or the IAS Classic Applet V4 and the 

Match On Card (MoC) applet, fingerprints can be used as an alternative to presenting a 

PIN. For fingerprint authentication, you must have a fingerprint scanner connected to 

the computer. (Please refer to the Classic Client Release Note to know which 

fingerprint scanners are supported.) To authenticate, place a finger on the sensor of 

the reader. Classic Client compares the digital fingerprint of the finger with the 

corresponding fingerprint stored in the MoC applet. 

Requirements

For fingerprint authentication to work, the fingerprints must already be present on the 

smart card. The smart card must have the MoC (Match on Card) algorithm loaded on it. 

The fingerprint authentication can be configured with the following options:

■ Configured fingerprints only

■ Any fingerprint (IAS Classic V4 only)

■ User PIN/Signature PIN or configured fingerprint (IAS Classic V4 only)

■ User PIN/Signature PIN or any fingerprint (IAS Classic V4 only)

■ User PIN/Signature PIN and configured fingerprint (IAS Classic V4 only)

■ User PIN/Signature PIN and any fingerprint (IAS Classic V4 only)

Caution: As with PINs, the number of attempts to perform a fingerprint authentication 

is limited. After a pre-defined number of failed attempts, you can no longer perform 

operations that require fingerprint authentication. YOU CANNOT UNBLOCK 

FINGERPRINT AUTHENTICATION USING CLASSIC CLIENT.
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Authentication Process

If the requirements are fulfilled and the applications are configured properly, the 

applications should prompt the user to authenticate with a PIN or fingerprint as shown 

below.

User must present the selected enrolled finger to scanner for fingerprint authentication.

Figure 8 - 1 to N Fingerprint Verification

User must present any enrolled finger to the scanner for fingerprint authentication.
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Figure 9 - 1 to 1 Fingerprint and User PIN Authentication

User must present selected enrolled fingerprint to the scanner followed by PIN to 

complete the authentication.

Figure 10 - 1 to N Fingerprint and User PIN Authentication

User must present any enrolled fingerprint to the scanner followed by PIN to complete 

authentication.
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Figure 11 - PIN-pad Authentication

When using a PIN-pad, “Figure 11” appears for authentication.

When any of the above dialog boxes appear:

1 Place the indicated finger and/or enter the PIN where applicable.

2 If successful, the fingerprint window disappears.

In the event of all fingerprints are blocked, enter the PIN as shown in “Figure 12”.

Figure 12 - PIN Authentication for Blocked Fingerprints

Note: All fingerprint dialog boxes may differ depending on enrolled fingerprints.
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4 

Background Service

When a smart card/token is connected, the Classic Client background service 

automatically reads the data on the smart card/token and performs some task such as 

prompting user to initialize PIN, notify user of certificate expiration and prompting user 

to enter transport PIN before proceeding to use IAS Classic applet functionalities.

Managing Background Service

Classic Client background service uses shell script to manage the Classic Client 

process.

The shell script is installed in /etc/ClassicClient and its name is ccchangepinservice.

The shell script takes in arguments that allow user to perform some task with the 

background service such as check status, stop or start or restart service, enable or 

disable service.

Note: User may need to have some knowledge on basic Linux terminal commands to 

manage the Classic Client background service.
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Below shows a list of functionalities to manage the background service:

Force Change PIN

The background service may detect that the User PIN or Signature PIN in the smart 

card/token must be changed. There are two main reasons for this:

■ The smart card/token is a brand new smart card/token whose PIN has not yet been 

initialized.

■ The smart card/token has had its User PIN or Signature PIN reset by the 

administrator, for example because it was blocked, and the administrator has set 

Force User to Change PIN.

In either case, when you connect the smart card/token a Change PIN dialog appears 

as shown below:

Figure 13 - Classic Client Background Service - Change PIN Dialog

Enter the values and click Change PIN.

For details about forced PIN changes when using a PIN Pad reader, the steps are 

similar to  “How to Change a PIN with PIN Pad reader” on page 33

Table 1 - Classic Client Background Service Management

Function Command

Check status whether background service is 
running

/etc/ClassicClient/ccchangepinservice status

Start background service etc/ClassicClient/ccchangepinservice start

Stop background service etc/ClassicClient/ccchangepinservice stop

Restart background service etc/ClassicClient/ccchangepinservice restart

Enable background service to be 
automatically started on next machine restart.

etc/ClassicClient/ccchangepinservice enable

Disable background service to not be 
automatically started on next machine restart.

etc/ClassicClient/ccchangepinservice disable
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Certificate Expiration

The Classic Client background service will notify user when one or more certificates 

soon-to-expire present in the smartcard/token. The prompt like in “Figure 14” will be 

shown if expiration date is 45 days or less.

Figure 14 - Classic Client Background Service - Certificate expiry notification

To change the default number of days prior certification expiration for notification, 

kindly approach any of our Thales technical support.

Transport PIN

The Classic Client background service may detect that transport PIN is activated in the 

smart card/token.

The service will ask user to verify transport PIN before allowing them to

resume activity.

In this case, when you connect the smart card/token, a verify transport PIN dialog

appears as shown:

Figure 15 - Classic Client Background Service - Verify Transport PIN dialog
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5 

Tasks

This chapter discusses information related to specific tasks that you will most often be 

required to carry out when using the Classic Client for Linux software and where to find 

the information about them. 

These tasks are:

■ “How to Use E-mail Securely” on this page.

■ “How to View Secure Web Sites” on page 24

■ “How to Add Digital Signatures to a Document” on page 27

■ “PACE Authentication” on page 36

Tasks concerning PINs are described in “Chapter 2 - PIN Management”.

How to Use E-mail Securely

The following sections explain how to send secure e-mail using Classic Client for Linux.
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About Secure E-mail

With Classic Client for Linux, you can improve e-mail security by using the digital 

certificate on your smart card/token to: 

■ Sign your e-mail so that the recipient can verify that the message is really from you 

and has not been altered.

■ Encrypt, or “scramble” a message so that only the intended recipient can read it. 

This eliminates concerns about intercepted messages and e-mail monitoring. 

■ Sign or encrypt your message using one e-mail program, while your intended 

recipient can read it with any other S/MIME-enabled e-mail program. 

■ Receive signed and encrypted e-mail messages.

Setting up Secure E-mail

You must do the following before you can send secure e-mail:

■ Configure the application to recognize the PKCS#11 security module

■ Configure security settings 

Set the security settings for digitally signing and/or encrypting the contents and 

attachments of outgoing messages.

■ Specify certificates to be used for signing and encryption

Choose the digital certificate(s) that you will use to encrypt and digitally sign your e-

mails. You can use the same certificate for both operations or two different ones. 

These certificates are associated with your e-mail account. 

■ Send yourself a digitally-signed e-mail 

When you send a signed e-mail, you sign it with the private key. The recipient 

receives the corresponding public key with the mail which he or she uses to 

decipher your mail.

Before you can send e-mails to anybody else, you need to send a signed message 

to yourself in order for Thunderbird to store your public key. 

Then you can send your public key to other people, for example by sending them a 

signed message. Once they have your public key, they can use it to encrypt mails 

they send to you (which you decipher using your private key).

The following sections describe how to perform the above operations using the Mozilla 

Thunderbird e-mail program. The dialog boxes shown may differ slightly from your own 

software, depending on what version you are using.

Working with Mozilla Thunderbird

The following sections explain how to set up and send secure e-mail with Mozilla’s 

Thunderbird e-mail program. 

There are three stages:

1 Configure Thunderbird to recognize the Security Module, described in the following 

section.

2 Configure the security settings and specify the certificates to use for signing and 

encryption, described on page 19.

3 Send a digitally signed e-mail to yourself in order to store your public key in 

Thunderbird, described on page 22.

Configure Thunderbird to Recognize the Security Module

You only need to do this once.
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To configure Mozilla Thunderbird

1 Make sure your smart card/token is connected.

2 Start Mozilla Thunderbird.

3 Enter your password if you are prompted for it and click on OK.

4 For the rest of the procedure, follow the instructions in "To configure Firefox to 

recognize the security module.

This new module will be used with all e-mail you send with Thunderbird.

Configuring Settings and Specifying Certificates

You only need to do this the first time you use your smart card/token to sign or encrypt 

an e-mail.

1 Make sure your smart card/token is connected.

2 Start Mozilla Thunderbird.

3 Enter your password if you are prompted for it.

4 In Thunderbird, click the Write icon .

This opens the Compose window.

5 In the Compose window’s Options menu, choose Security > Encrypt This 

Message as shown in “Figure 16”.

Figure 16 - Encrypt This Message
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As the certificates in the smart card/token are not yet set up, the following message 

appears:

6 Click Yes. This opens the security account settings window for your e-mail account 

as shown in “Figure 17” on page 20.

Figure 17 - Security Account Settings

7 In Digital Signing, click Select and choose the certificate you want to use from the 

list that appears. 

Figure 18 - Enter Password

The details of the selected certificate appear, as shown in “Figure 19”.

Note: You may be prompted to enter a “master password” as shown in “Figure 18”. If 

so, enter the PIN for the card and click OK. This can be a User PIN or a Signature PIN.
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Figure 19 - Details of Selected Certificate

8 Click OK. The following message appears:

Figure 20 - “Use Same Certificate” Message

9 If you want to use the same certificate to encrypt and decrypt messages, click OK. 

This selects the certificate for you in the Encryption panel as shown in “Figure 21”. 

Otherwise click Cancel. 

Figure 21 - Security Account Settings (2)

10 If you want all of your e-mails to be digitally signed by default, check the box 

Digitally sign messages (by default).
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11 In Encryption, if you chose not to use the same certificate as the one used for 

digital signing, click Select and choose the certificate from the list that appears. A 

message similar to the one in “Figure 20” on page 21 appears, but this time asking 

if you want to use the Encryption certificate for digital signing. This is just in case 

you select your encryption certificate before you select your digital signature 

certificate.

12 In Default encryption setting when sending messages, choose one of the 

option buttons Never or Required.

13 Click OK to close the Security Account Settings window.

Sending Digitally Signed E-mail with Mozilla Thunderbird

To send a signed e-mail to yourself with Mozilla Thunderbird

1 Make sure your smart card/token is connected.

2 Start Mozilla Thunderbird.

3 Enter your password if you are prompted for it.

4 In Thunderbird, click the Write icon .

This opens the Compose window.

5 In the Compose window, write a short message addressed to yourself.

Be sure to include a subject heading.

Figure 22 - New Msg Composition Window

6 From the Options menu in the Compose window, choose Security > Digitally 

Sign this Message in order to sign the message. 

Note: If you want to modify the account settings at any point, open the Account 

Settings window from the Tools menu by choosing Account Settings.
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Figure 23 - Message Security Info Window

You can display details about the certificate by clicking View. 

7 Click OK to close the Message Security window.

8 Back in the Compose window, click Send.

If you are prompted for a master password for your security module, as shown in 

“Figure 18” on page 20, then enter the PIN for your smart card/token.

9 Open the message you sent yourself from in your inbox.

Notice the  icon showing you that the message has been signed.

You have successfully sent yourself a digitally signed e-mail.

Now that Thunderbird recognizes your public key, you can send signed messages 

to other people, thus sending them your public key.

Sending Encrypted E-mail with Mozilla Thunderbird

Once you have configured your e-mail account in Mozilla Thunderbird, you can 

retrieve a person’s public key when he or she sends a signed message to you. When 

you send e-mail to that person, you use his or her public key to encrypt the e-mail. This 

is done automatically by Thunderbird; you just need to specify the recipient(s) of the 

mail. Since no one except the person who has the private key can decrypt it, the e-mail 

is secure.

To send an encrypted e-mail:

Follow the same steps as “To send a signed e-mail to yourself with Mozilla 

Thunderbird” on page 22, except in the Compose window, choose Encrypt this 

message from the Options menu. 

Reading Encrypted E-mail with Mozilla Thunderbird

When you open an encrypted e-mail, the application prompts you for a password. 

Enter the User PIN of your smart card/token to decrypt and read the e-mail.
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How to View Secure Web Sites

Communicating and conducting business on the Web is quickly becoming the most 

convenient, effective means of transaction. Therefore, Web sites must be secure to 

protect the corporation, the individual and the information exchanged.

With your Classic Client smart card/token, you can browse secure Web sites knowing 

that your private key and digital certificate are safely stored on your smart card/token 

instead of your hard drive, where they might be susceptible to unauthorized access.

When you connect to a secure Web site, your certificate must be specified in your 

browser so that you can authenticate yourself to the Web server. For example, when 

you bank online, your bank must be sure that you are the correct person to get account 

information. Your certificate confirms your identity to the online bank. 

The following sections explain how to check that your certificates are correctly 

registered in your browsers when authenticating with secure web sites using Mozilla 

Firefox.

Choosing a Certificate to Authenticate Yourself to Secure Web Sites

To authenticate using the Mozilla Firefox browser, your certificate must be registered in 

the browser. This section describes how to check that a certificate is registered and 

also how to tell the browser whether it should select the certificate itself, or ask you.

The screen shots in this section were made using Firefox.

To check certificates registered in Mozilla Firefox: 

1 Make sure your smart card/token is connected.

2 Open Mozilla Firefox.

3 From the Edit menu choose Preferences. 

4 Click the Advanced icon, then the Certificates tab as shown in “Figure 24”. 
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Figure 24 - Mozilla Firefox Options Dialog

5 In Certificates, choose one of the options for the action to take when a web site 

requires a certificate:

– Select one automatically

– Ask me every time

6 To display the certificates that are on your smart card/token, click View 

Certificates. You will be prompted for a password as shown in “Figure 25”.

Figure 25 - Password Required
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7 Enter the User PIN for your smart card/token.

The Certificate Manager window appears.

Figure 26 - Certificate Manager Window

8 Under Your Certificates appears the certificates that are stored on the smart card/

token. To display the properties of a particular certificate, select it and click View. 
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How to Add Digital Signatures to a Document

This section explains how to add digital signatures to a document and how to sign PDF 

documents. Users are able to add the digital signatures using LibreOffice. 

Configure LibreOffice to Recognize the Security Module

You only need to do this once.

To load Security Module

1 LibreOffice shares the same PKCS#11 module in Mozilla Firefox or Thunderbird’s 

Device Manager to have access to smartcard/token. 

2 Hence, ensure Classic Client’s PKCS#11 module is loaded to the Device Manager 

prior using LibreOffice. Refer to “Configuring Thales Cryptographic Security 

Modules” on page 2 for details.

To configure Network Security Services certificate directory

1 In LibreOffice, go to Tools and click Options.

2 Click Security, and under Certificate Path select Certificate.

3 Select either Mozilla Firefox or Thunderbird directory that the security module was 

previously loaded.

Adding Digital Signatures to a Document or PDF

The steps are shown below:

1 In LibreOffice, go to File and click Digital Signatures and select Sign Digital 

Signatures.

2 If the document is not saved, the user is prompted to save. Save the document and 

click Digital Signatures again.

Note: LibreOffice uses the PKCS#11 module in Mozilla Firefox or Thunderbird’s 

Device Manager to have access to smartcard/token. Hence, ensure Classic Client’s 

PKCS#11 module is loaded to the Device Manager prior using LibreOffice. Refer to 

“Configuring Thales Cryptographic Security Modules” on page 2 for details.
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Figure 27 - Digital Signatures

3 Click Sign Document and enter the PIN to view the available certificates on the 

card. This PIN can be a user PIN or Signature PIN.

Figure 28 - Digital Signatures User PIN Entry

4 Select a certificate to sign with and click OK.
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Figure 29 - Digital Signatures Certificate Selection

5 The document is signed and the signature is validated.

Figure 30 - Digital Signatures Validated

How to Use Soft PIN Entry

The user can enter the PIN using the soft keyboard for PIN entry after the card is 

inserted into the transparent reader for authentication as shown below:

Figure 31 - Authentication using Soft PIN Entry

1 Enter the PIN using the PIN pad.

2 Once the PIN is sufficient, click Enter PIN to login.
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Figure 32 - Authentication using Soft PIN Entry 2

How to Change a PIN with Soft PIN Entry

To perform this operation, the Classic Client setup must have been granted the 

“Change User PIN allowed” access rights by the administrator.

To Change a PIN

1 Ensure smart card/token is connected and login as shown in previous section.

2 Click the Change PIN tab and select your PIN.

Figure 33 - Changing User PIN using Soft PIN Entry

3 Click Change PIN to access the PIN pad.

4 Enter the current PIN in the PIN pad window and click Enter PIN.

Figure 34 - Changing User PIN using Soft PIN Entry 2

5 The PIN pad window reappears to prompt for the new PIN value and confirm the 

new value.

Enter the new PIN and click Enter PIN in both windows.
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Figure 35 - Changing User PIN using Soft PIN Entry 3

6 The following window appears to confirm a successful PIN change.

Figure 36 - Changing User PIN using Soft PIN Entry 4
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How to Unblock a PIN with Soft PIN Entry

To perform this operation, the Classic Client setup must have been granted the “User 

can Unblock card” access rights by the administrator.

To Unblock a PIN

1 Login as shown in previous section.

2 Click the Unblock PIN tab and select type of PIN to unblock.

3 Check the box for “Force user to change PIN” if required.

Figure 37 - Unblocking User PIN using Soft PIN Entry

4 The following windows appear to prompt for the Admin PIN. Enter the PIN and click 

Enter PIN to continue.

Note: This section is applicable only for user PIN and signature PIN. It is not possible 

to unblock an Admin PIN. If the Admin PIN becomes blocked, the smart card/token 

can no longer be used.
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Figure 38 - Unblocking User PIN using Soft PIN Entry 2

How to Use PIN Pad reader

The flow of usage is similar to that of soft keyboard for PIN entry except that user is 

entering the PIN using physical PIN pad reader after the card is inserted to the same 

reader.

For authentication, user needs to input the correct PIN at the PIN pad reader after 

being prompted for it.

Figure 39 - Authentication using PIN Pad reader

How to Change a PIN with PIN Pad reader

To perform this operation, the Classic Client setup must have been granted the 

“Change User PIN allowed” access rights by the administrator.

To Change a PIN

1 Ensure smart card/token is inserted into PIN pad reader.

2 Click the Change PIN tab and select your PIN.
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Figure 40 - Changing PIN using PIN Pad reader

3 Click Change PIN and a prompt asking user to input default/current PIN value in 

the PIN pad reader will be shown.

Figure 41 - Changing PIN using PIN Pad reader 2

4 Enter the default/current PIN in the PIN pad reader.

5 Another prompt will be shown, asking user for default/current and new value of the 

PIN.

Figure 42 - Changing PIN using PIN Pad reader 3

6 A confirmation dialog will be shown after PIN change is successful.

Figure 43 - Changing PIN using PIN Pad reader 4

How to Unblock a PIN with PIN Pad reader

To perform this operation, the Classic Client setup must have been granted the 

“Change User PIN allowed” access rights by the administrator.

Note: This section is applicable only for user PIN and signature PIN. It is not possible 

to unblock an Admin PIN. If the Admin PIN becomes blocked, the smart card/token 

can no longer be used.
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To unblock a PIN

1 Ensure smart card/token is inserted into PIN pad reader.

2 Click the Unblock PIN tab and select your PIN.

Figure 44 - Unblocking PIN using PIN Pad reader

3 Select force user to change PIN if needed.

4 Click Unblock PIN and a prompt asking user to input default/current Admin PIN 

value in the PIN pad reader will be shown.

Figure 45 - Unblocking PIN using PIN Pad reader 2

5 Enter the default/current Admin PIN value in the PIN pad reader.

6 Another prompt will be shown, asking user for default/current Admin PIN value and 

new value of the PIN.

Figure 46 - Unblocking PIN using PIN Pad reader 3

7 A confirmation dialog will be shown after PIN unblock is successful.
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Figure 47 - Unblocking PIN using PIN Pad reader 4

PACE Authentication

Password Authenticated Connection Establishment (PACE) is a security feature for 

contact and contactless cards that require the terminal and the card to share a simple 

secret in order to authenticate each other. PACE is based on the Diffie-Hellman 

protocol for strong mutual authentication. PACE also aims to ensure user privacy 

protection on contactless cards the same way CSD do, but with a higher level of 

security:

■ Authentication is based on Card Access Number (CAN), Machine Readable Zone 

(MRZ), or possibly a PIN (proprietary solution).

■ It is a standardized solution specified by ICAO for ePassport and eResident Permit 

Card.

■ It is introduced in the GlobalPlatform (GP) standard for MultiApp platform use.

■ It generates session keys that can be used by ISD (or some applications) to 

compute a strong secure messaging between the card and terminal.

PACE V2 is supported in Classic Client and on Classic Applet V4. If a card reader tries 

to access a PACE-protected smart card, Classic Client prompts you for any of the 

following passwords (depending on how the card is personalized):

■ CAN

■ MRZ

■ Global PIN

Enter the PACE passwords using the virtual keyboards as shown in “Figure 48”. The 

virtual keyboards are not displayed by default. Click the icon  to access the virtual 

keyboard as shown in “Figure 49”.
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Figure 48 - PACE Authentication Dialog Boxes
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Figure 49 - PACE Authentication Dialog Boxes and Virtual Keyboards
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Reader Exclusion in Configuration File

To exclude a reader, the user is required to add the full reader name in the 

configuration file. In addition to the full name, it is required to include a colon, space 

and NotInUse after the full name as shown below:

1 Get the full reader name by typing pcsc_scan command in Linux terminal.

2 Add the complete reader name in /etc/ClassicClient/ExcludedReaders/conf. 

Format

■ <reader_name>:<space><NotInUse>

Example 

■ Gemalto Prox Dual USB PC Link Reader [Prox-DU Contact_10901084] 00 00: 

NotInUse.

■ Gemalto Prox Dual USB PC Link Reader [Prox-DU Contactless_10901084] 01 00: 

NotInUse.

Note: The user must remove the reader form the configuration if the reader is to be 

included.
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A

Security Basics

This chapter introduces you to the IT security standards integral to Classic Client.

Cryptography

Communicating and conducting business electronically is quickly becoming the most 

convenient, effective means of transaction. An essential condition for the continued 

growth toward an electronic market is security. The identities of both corporations and 

individuals must be authentic. The integrity and privacy of information must be 

guaranteed.

Encryption/decryption enables you to send and receive secure e-mail and documents 

to protect confidential or private information. You can use the signature function to sign 

your messages. By signing messages, you can prove to the recipient that you are who 

you claim to be.

The IT industry uses cryptography to render information secret and known only by 

authorized entities.

There are two types of cryptography:

■ Secret Key Cryptography.

■ Public Key Cryptography

Both cryptographic systems use keys to digitally sign or encrypt/decrypt data. A key is 

a value in electronic format used to perform cryptographic functions on electronic data.

The differences between secret key and public key cryptography include:

■ Key management.

■ Complexity of the key structure.

Key management is central to having a successful crypto system. If keys are not 

managed in a secure environment, the overall security of the crypto system is at risk. 

Keys must also be convenient to use.

The complexity of a key length is determined by the degree of mathematical properties 

applied to the random numbers that comprise the key.



41

Classic Client for Linux User Guide

D1573654A May 9, 2022 Copyright © 2022 Thales Group. All rights reserved.

Secret Key Cryptography

Secret key cryptography is the traditional crypto system, which remains in widespread 

use even today. Secret key cryptography uses a single secret key to digitally sign or 

encrypt/decrypt electronic data. The most widely used secret key crypto systems are 

DES and RC2 (also known as symmetric key cryptography). 

The sender and receiver must use the same secret key for the session in which secure 

information is exchanged. The sender uses the secret key to encrypt the message; the 

receiver uses the same secret key to decrypt the message.

The primary advantage of secret key cryptography is the speed at which data can be 

encrypted/decrypted. 

The primary weakness of secret key cryptography regards key management. Because 

sender and receiver must share knowledge of the secret key, there must be a transfer 

of the secret key at some point. Introducing a third party (such as a telephone line or 

courier) to deliver the secret key to the receiver presents a security risk.

Secret keys are included in the cryptographic functionality of Mozilla e-mail and 

browser products. 

Public Key Cryptography

Public key cryptography was introduced in 1976 and is the most advanced, secure 

crypto system for digitally signing and encrypting/decrypting electronic data. Public key 

cryptography refers to a crypto system that uses key pairs. The most popular and 

widely-used public key crypto system uses the RSA key pair.

A key pair is a matched set of keys used to digitally sign or encrypt/decrypt electronic 

data. RSA key pairs, like secret keys, are strings of random numbers. However, RSA 

keys are not only significantly longer than secret keys, they also possess complex 

mathematical properties.

A single user owns an RSA key pair. One key is private, while the other key is public. 

The private key remains private and accessible only to the owner of the key pair. The 

public key is made available by the owner to public users. The public key is used to 

encrypt data. The private key is used to decrypt data.

The strengths of using an RSA key pair is that the need for sender and receiver to 

share knowledge of the single secret key used in secret key crypto systems is 

eliminated. 

Classic Client takes advantage of the speed the secret key offers and the robust 

security and convenience of the RSA key pair. When you use Classic Client to send 

secure e-mail, the actual message data is encrypted using a secret key. The secret key 

is then encrypted using the public key of the intended recipient. Only the recipient's 

private key can decrypt the secret key. Only the secret key can decrypt the message 

data.

Classic Client offers the most advanced digital security at the greatest speed and 

convenience.
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What is a digital certificate?

A digital certificate is an electronic document that serves as your digital passport. Your 

digital certificate stores your public key and other personal information about you and 

the certificate.

The most widely accepted standard for digital certificates is defined by International 

Telecommunications Union standard ITU-T X.509. Version three is the most current 

version of X.509.

The X.509v3 certificate includes the following data:

■ Version.

■ Serial number.

■ Signature algorithm ID.

■ Issuer name.

■ Expiration Date.

■ User name.

■ User public key information.

■ Issuer unique identifier.

■ User unique identifier.

■ Extensions.

■ Signature on the above fields.

As a convenience to recipients, it is standard practice to attach your digital certificate to 

every secure e-mail that you send. The recipient uses your public key, included in your 

digital certificate, to encrypt e-mail addressed to you. If you do not attach your digital 

certificate to outgoing e-mails, recipients must retrieve your public key from a public 

directory if they want to reply to you with an encrypted e-mail.

What is a Certificate Authority?

Certificate Authorities (CAs) are trusted third parties that issue digital certificates. CAs 

vouch for the identity of the individual or enterprise to whom they are issuing a 

certificate. CAs provide a transfer of trust from CA to the individual or enterprise. When 

you trust the CA certificate, you can transfer that trust to all certificates published by 

that CA.

When you obtain your digital certificate, you provide the CA with your public key and 

any personal information requested by the CA. The CA verifies your personal 

information and the integrity of your public key. After the verification process, the CA 

signs your public key, stores appropriate personal information and your public key on 

the digital certificate, and issues your digital certificate to you. 

CAs issue certificates with varying levels of identification requirements. CA policies and 

the level of identification of the digital certificate determine the method and 

requirements for proving your identity to the CA. The most simple digital certificate only 

requires your e-mail address and name. However, some CAs require a driver's license, 

notarized certificate request form, or any other personal documentation attesting to 

your identity. 

The CA public key must be widely available so that users can validate the authenticity 

of all certificates published by this CA.

What is a digital signature?

A digital signature is a piece of information created using message data and the 

owner's private key. Digital signatures provide message authentication, non-

repudiation of origin, and data integrity.
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Digital signatures are created by mathematical, or hash, and private signing functions. 

The one-way hash function produces a message digest, a condensed version of the 

original message text. The message digest is encrypted using the sender’s private key, 

turning it into a digital signature.

The digital signature can only be decrypted using the public key of the same sender. 

The recipient of the data decrypts the digital signature and compares the result with a 

message digest, recalculated from the original message text. If the two are identical, 

the message was not manipulated, thus is authentic.

What is S/MIME?

Secure/Multipurpose Internet Mail Extensions (S/MIME) is an open protocol standard, 

that provides encryption and digital signature functionality to Internet e-mail. S/MIME 

uses public key cryptography standards to define e-mail security services.

S/MIME enables you to encrypt and digitally sign Internet e-mail using Web messaging 

applications such as Mozilla Thunderbird. S/MIME also enables you to authenticate 

incoming messages.

S/MIME provides the following security functions:

■ Sender Authentication to verify the sender's identity. By reading the sender's 

digital signature, the recipient can see who signed the message and view the 

certificate for additional details.

■ Message Encryption to ensure that your messages remain private. Mozilla 

Thunderbird supports domestic and export-level public key and secret key 

encryption.

■ Data Integrity to guard against unauthorized manipulation of messages. S/MIME 

uses a secure hashing function to detect message tampering.

■ Inter-operability to work with other S/MIME-compliant software.

What is TLS?

Transport Layer Security (TLS), developed by Netscape Communications, is a 

standard security protocol that provides security and privacy on the Web. The protocol 

allows client/server applications to communicate securely. TLS uses both public and 

secret key cryptography.

The TLS protocol is application independent, which enables higher-level protocols 

such as Hyper Text Transfer Protocol (HTTP) to be layered on top of it transparently. 

Therefore, the client can negotiate encryption and authentication with the server before 

data is exchanged by the higher-level application.

The TLS Handshake Protocol process includes two phases:

■ Server Authentication in which the client requests the server's certificate. In 

response, the server returns its digital certificate and signature to the client. The 

server certificate provides the server's public key. The signature proves that the 

server currently has the private key corresponding to the certificate.

■ Client Authentication (optional) in which the server requests the client's 

certificate. In response, the client sends the digital certificate and signature to the 

server. If the TLS Server requests it, the client is prompted to enter a PIN to visit a 

secure Web site.

The TLS process is repeated for every secure session you attempt to establish unless 

you specify a permanent session. The TLS process will not proceed if the Web server's 

certificate is expired.

Note: In some instances, the TLS Handshake takes place between the Web server 

and the browser and does not require the client’s certificate.
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TLS provides the following security functions:

■ Data Encryption to ensure data security and privacy. Both public key and secret 

key encryption are used to achieve maximum security. All traffic between an TLS 

server and TLS client is encrypted using both public key and secret key algorithms. 

Encryption thwarts the capture and decryption of TCP/IP sessions.

■ Mutual Authentication to verify the identities of the server and client. Identities are 

digital certificates. The entity presenting the certificate must digitally sign the data 

to prove ownership of the certificate. The combination of the certificate and 

signature authenticates the entity.

■ Data Integrity to ensure that TLS session data is not manipulated en route. TLS 

uses hash functions to provide the integrity service.

What is PACE Authentication?

Password authenticated connection establishment (PACE) is a service that can be 

used by the smart card. The PACE Protocol is a password authenticated Diffie-

Hellman key agreement protocol that provides secure communication (secure 

messaging) and password-based authentication of the smart card and the inspection 

system (that is, the smart card and inspection system share the same password).

What is Classic Client?

Classic Client is a smart card based solution designed to secure e mail 

communications and Internet transactions. Classic Client smart cards/tokens support 

encryption/decryption and signature functions. 

Classic Client and a smart card/token provide the following advantages:

■ Your private key is never removed from your smart card/token.

■ The smart card/token is hardware-based security.

■ The PIN code protects key use.

■ Classic Client is portable and convenient.

The encryption/decryption function enables you to send and receive secure e-mail to 

protect confidential or private information. You can use the signature function to sign 

your messages. By signing messages, you can prove to the recipient that you are who 

you claim to be.

Classic Client combines the privacy, integrity, and authentication functionality provided 

by cryptographic algorithms with the simplicity, portability, and convenience of smart 

cards/tokens. Your private key, digital certificate, and other personal information are 

securely stored on your Classic Client smart card/token to prevent fraudulent use of 

your electronic identity.

The latest industry standards such as TLS (for Web access) and S/MIME (for e mail) 

enable inter operability of security services between any browser interface and any 

Web server. However, the security hole in TLS and S/MIME is the management of your 

private key and digital certificate. Without Classic Client, your private key and digital 

certificate are stored on your hard drive, which makes them susceptible to 

unauthorized access and fraudulent use. Without Classic Client, your electronic identity 

is at risk.

Classic Client provides double-barreled security! Classic Client, you get the hardware-

based security inherent in smart cards/tokens and software-based encryption security, 

as well as the added advantage of individual PIN codes. Hardware-based security is a 
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principal security advantage. It is significantly more secure than software-only 

solutions. Without the possession of your smart card/token and knowledge of your PIN 

code, no one can use your identity.

Classic Client is your electronic passport to the digital world.

What is a Smart Card/Token?

A smart card is the size of a conventional credit card. But unlike the credit card, which 

has a magnetic stripe, the smart card has a silicon microprocessor chip to store and 

process electronic data and applications. The advantage of the smart card is security.

Thales manufactures various types of smart cards. Contact smart cards use a 

microprocessor chip to store and process data. They must be inserted into a smart 

card reader. Contactless smart cards use a microprocessor chip and antenna to store 

and process data.

Smart cards can also be embedded in tokens such as USB devices, that you can plug 

directly into a PC.

Smart cards/tokens provide the most sophisticated security available on the market.

What is the Classic Client Smart Card/Token?

Your Classic Client smart card/token stores your private key and digital certificate. In 

the past, your only option was to store your private key on your local hard drive, 

rendering it susceptible to theft and fraudulent use. With Classic Client, your electronic 

identity is secure. You must have both the smart card/token and PIN code to use the 

smart card/token.

The Classic Client smart card/token is tamper resistant. The structure and operating 

system of the smart card/token make it practically impossible to penetrate, probe, or 

pilfer smart card/token data.

Perhaps the most convenient aspect of the Classic Client smart card/token is 

portability. With Classic Client, you can carry your electronic passport with you at all 

times and use it on any Classic Client–equipped computer in the world.

The Classic Client smart card/token has a robust and flexible design. These features 

offer greater freedom and enhanced security.

On-board Key Generation

The Classic Client smart card/token offers on-board key generation. With this feature, 

every time you enroll a new certificate on your smart card/token, a new key pair is 

generated on your smart card/token. In other words, you are not limited to using the 

same key pair for every certificate that you enroll.

One significant advantage of onboard key generation is the ability to monitor and 

control the life span of your RSA key pairs and that the generated key pair is unique.

Increased Certificate Storage

You can store up to six key pairs and multiple digital certificates on your Classic Client 

smart card/token, depending upon the size of your certificates and space available on 

your smart card/token. This feature provides the convenience of using up to eight 

digital certificates for whatever purposes you want; for example, you can use 

certificates with varying degrees of encryption (from 1024–bit to 2048–bit RSA key 

pairs) to communicate securely with contacts in various parts of the world.
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Another reason for obtaining more than one digital certificate is the level of certification 

that the Certificate Authority (CA) requires. You may want to obtain and use a digital 

certificate from a CA that requires stringent identity certification if you are using the 

certificate for sensitive business communications or financial transactions. However, if 

you want to encrypt/sign data for personal communications, you may decide that a 

certificate from a CA that requires minimal identity certification meets your needs.

The costs of obtaining a digital certificate from a CA are somewhat based on the 

degree of identity certification the CA requires.
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Terminology

Abbreviations

CA Certificate Authority

ID Identification

IMAP Internet Message Access Protocol

OS Operating System

PIN Personal Identification Number

PKCS Public Key Cryptography Standard

PKCS#11 Public Key Cryptography Standard #11. For further 
information about this, refer to theOASIS Open Standards 
Web site at http://docs.oasis-open.org/pkcs11

POP Post Office Protocol

RHEL Red Hat Enterprise Linux

RSA Rivest, Shamir, Adleman (inventors of public key 
cryptography standards)

S/MIME Secure/Multipurpose Internet Mail Extensions

TLS Transport Layer Security

http://www.rsa.com/rsalabs
http://docs.oasis-open.org/pkcs11
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Glossary 

Algorithm A mathematical formula used to perform computations that 
can be used for security purposes.

Certificate A certificate provides identification for secure transactions. It 
consists of a public key and other data, all of which have been 
digitally signed by a CA. It is a condition of access to secure e-
mail or to secure Web sites.

Certificate 
Authority

An entity with the authority and methods to certify the identity 
of one or more parties in an exchange (an essential function in 
public key crypto systems).

Cryptography The science of transforming confidential information to make it 
unreadable to unauthorized parties.

Digital Signature A data string produced using a Public Key Crypto system to 
prove the identity of the sender and the integrity of the 
message.

Encryption A cryptographic procedure whereby a legible message is 
encrypted and made illegible to all but the holder of the 
appropriate cryptographic key.

Key A value that is used with a cryptographic algorithm to encrypt, 
decrypt, or sign data. Secret key crypto systems use only one 
secret key. Public key crypto systems use a public key to 
encrypt data and a private key to decrypt data.

Key Length The number of bits forming a key. The longer the key, the 
more secure the encryption. Government regulations limit the 
length of cryptographic keys.

Public Key Crypto 
system

A cryptographic system that uses two different keys (public 
and private) for encrypting data. The most well-known public 
key algorithm is RSA.

SSL Secure Sockets Layer: A Security protocol used between 
servers and browsers for secure Web sessions.

SSL Handshake The SSL handshake, which takes place each time you start a 
secure Web session, identifies the server. This is 
automatically performed by your browser.

S/MIME A Standard offline message format for use in secure e-mail 
applications.

TLS Transport Layer Security protocol provides communications 
security over the Internet.  The protocol allows client/server 
applications to communicate in a way that is designed to 
prevent eavesdropping, tampering, or message forgery.
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TLS Handshake When a TLS client and server first start communicating, they 
agree on a protocol version, select cryptographic algorithms, 
optionally authenticate each other, and use public-key 
encryption techniques to generate shared secrets.

Token In a security context, a token is a hardware object like a smart 
card, but it could also be a pluggable software module 
designed to interact with a specific hardware module, such as 
a smart card. Token-based authentication provides enhanced 
security because success depends on a physical identifier (the 
smart card) and a personal identification number (PIN).
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